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Teacher Guide

Lessons for High School Students: Grades 9 - 12 

Technology Project using 

Microsoft 

Access 365
Construct a space exploration database.

In this project, students learn database skills. To start, they work with an existing 

database about space exploration. Next, students edit their photograph, to 

place a copy of their head into a space suit. This image and their personal 

information are entered into a form to practice data entry techniques. Once 

students learn the basics of Microsoft Access, they begin construction of a 

database. They use the Internet to research information and collect pictures. 

Next, students create a blank database to catalogue the data they gathered 

from the Internet. The database will contain a table used to store the data, a 

form for simple data entry, and a report that summarizes the data in an 

attractive format. 
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Project Overview 

 

Introduction to TechnoMission 

 

In this project, students learn database skills. To start, they work with an existing database about 

space exploration. Next, students edit their photograph to place a copy of their head into a space 

suit. This image and their personal information are entered into a form to practice data entry 

techniques. Once students learn the basics of Microsoft Access, they begin construction of a 

database. They use the Internet to research information and collect pictures. Next, students 

create a blank database to catalogue the data they gathered from the Internet. The database 

will contain a table used to store the data, a form for simple data entry, and a report that 

summarizes the data in an attractive format. 

 

Students complete the following tasks: 

 

• In session 1, students learn about the history of space exploration. To start, students 

examine a timeline of historic events. Afterwards, students open a database that 

contains information about space missions. They view records in the database to learn 

about important events such as when man landed on the moon, deployed the Hubble 

Space Telescope, or lived on the International Space Station. By filtering records, students 

can read about the space program from its early beginnings in the 1960's to today. 

• In session 2, students become astronauts. Using Microsoft Paint, students edit a 

photograph to place their head into a spacesuit. Upon completion, students join the 

prestigious team at TechnoNASA. The edited photograph, as well as other personal 

information is entered into the Space Exploration database. 

• In session 3, students blast into cyberspace. Their mission is to collect items from the World 

Wide Web and store the information in a database. To prepare for this mission, students 

complete a planning sheet. This organizer helps them pick a topic and the fields of 

information that will be in the database. Afterwards, students use the Internet to search 

for information. Facts are recorded in an organizer and pictures are collected of each 

item. This information will be added to a database that students will construct in 

upcoming sessions. 

• In session 4, students begin construction of a database to catalogue items discovered on 

their mission into cyberspace. To start, students create a table in the database that 

includes fields such as item name, description, date, and category. The properties on 

each field are adjusted to make data entry consistent. 

• In session 5, students design a simple data entry form. To start, they open their database 

and select the table. Using the Form Wizard students quickly make a form with a 

standard layout. With the commands in Design View students change the style of the 

form and resize the controls. Afterwards, data for each object collected on the 

cyberspace mission is entered into the database using the form. 

• In session 6, students generate a simple report. To start, they open their database and 

select the table. Using the Report command, students quickly make a report with a 

standard layout. Using the commands in Layout View students change the style, 

orientation, and controls on the report. Once the report looks great it is printed. Now 

students have an attractive printout that summarizes their cyberspace mission.  

MISSION COMPLETE! 
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Implementation and Technology Integration Ideas 

TechnoMission is an introduction to databases. The instructions explain how to organize 

information using Microsoft Access. Through hands-on activities students learn the purpose of a 

table, form, and report.  

 

Use these suggestions to integrate activities into curriculum: 

 

• Computer Applications Course 

Include this project as part of a computer studies course. The activities provide an 

understanding of how to use the program Microsoft Access to organize information. 

 

• Database Unit for Beginners 

Teach this project to introduce database concepts in a fun way. To start, students learn 

how to view, sort, and enter records into fields by using an existing database about 

space exploration. Afterwards, they follow instructions to design their own database that 

organizes information about a topic of their choice. Step-by-step instructions explain how 

to construct a table, form, and report. 

 

• Business Studies Class 

Complete this project as part of a business studies class. In Session 3, have students invent 

a company.  They must decide the product they want to sell. For example, they may 

operate a bookstore, toy shop, or clothing outlet. 

 

 

Topic Selection 

 

A database can be created on any topic that can be organized into a range of categories and 

data types such as a picture, name, description, date, and group. 

 

• Science: Apply the skills learned in the space exploration database to create a 

database of specific biology, chemistry, or environmental concepts. 

• Social Science and Humanities: Build a database comparing diverse cultural issues, 

summarizing equity studies, listing nutrition facts, or recording stages of human 

development. 

• English: Construct a database to compare the characteristics of a particular text form: 

folk tales from diverse cultures, newspaper articles, film scripts, or graphic novels. 

• Arts: Inventory artists or composers, music or art styles, dance genres, or drama traditions.  
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Assignment 2: What is a Database? 
 

 
 

 

What is a Database? 

Databases are used everywhere in the world today. For example, a store may 

use a database to organize product information. Or an office may use a 

database to organize customer information. 

 

A database is a collection of information that is stored on a computer using a 

program such as Microsoft Access. A database lets you organize and find lots 

of information quickly and easily.  

 

A database is like a big filing cabinet. It holds, or stores, information on your computer.  

 

In a filing cabinet are folders. A database does not use folders, instead it has tables. A table is a 

grid, made up of columns and rows that are used to store data. 

 

 
 

 

 

Each folder in a filing cabinet holds paper. A database does not use paper. Instead, a database 

has forms. A form is like a piece of paper that you see on your computer screen. You can use it to 

read information in the database or add new information into a table. 

 

 

 
  

You will be going on a cyberspace mission. Your job will be to collect data from 

websites in cyberspace and organize the information using a database. 

 

To prepare for the mission you need to learn about databases.  

Table 

Form 
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In a filing cabinet are pieces of paper with information on each one. In a database, we call the 

piece of paper with information a record. A record is a group of data about one person, event, 

or thing.  

 
 

On each piece of paper are words or pictures. In a database, we call each word and picture a 

field. A field is one piece of data in a record. A record has many fields. 

 

 

 
 

 

Answer Questions about a Database 

1. What is a database? 

 A database is a collection of information that is stored on a computer. 
  

2. Why would a person want to use a database to store information? 

 A database lets a person organize and find lots of information quickly and easily. 
  

3. What is a table? 

 A table is a grid made up of rows and columns used to store information. 
  

4. What is a form? 

 A form is sheet that has controls that are used to view and enter information into a table. 
  

5. What is a record? 

 A record is a group of information about a person, thing, or event. 
  

6. What is a field? 

 A field is one piece of data in a record. 
  

7. You are going to look at a database of space missions. What type of data do you think 

will be in the database? 

  

  

 

Field 

Field 

Field 

Record 

Field 

Field 

Fields 
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Assignment 10: Cyberspace Mission Planning Sheet 
 

You will be going on a cyberspace mission. Your mission is to use the 

Internet to collect data from websites in cyberspace and organize the 

information using a database. 
 

You can pick any topic. You may wish to make a database about 

music, celebrities, sports, television, movies, fashion, food, animals, art, 

explorers, books, or planets. You will add six records to the database 

about the topic. Each record will include a picture and information. 
 

Before you can blast off into cyberspace, you need to plan the type of information you will 

collect to create a database. 

 

Plan the Content of the Database 

Answer the questions to plan the content of your database. 

 

1. What is the topic of your database? 

  

 

2. Look at the form. Your database will have similar information. Read about each field 

and answer the questions to plan the fields you will need for each record. 

 

 
 

 a) Picture: You must collect a picture for each record. If you were making a database 

about musicians, you might want to include a picture of the singer or an album 

cover. 

What type of picture will you collect? 

   

 

 b) Item Name: You will record the name of the item. If you were making a database 

about artwork, the item name might be the name of the painting or artist. 

What type of information will you record for item name? 
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 c) Date: Each record will have a date field. The date can be the day the data was 

collected, the date an item was released, a birthdate, or a significant date for the 

item. 

What date label suits your database topic? 

   

 

 d) Description: You will describe the item. If you were making a database about 

movies, you could describe the plot or rate the film. 

What type of description will you give about the item? 

   

 

 

 e) Category: You need to categorize each item. If you were making a database 

about books you could sort by genre (mystery, romance, science fiction), or if 

collecting information on celebrities you might sort by type such as rock star, actor, 

or athlete. 

List the categories you will use to sort each item: 

   

   

   

 

 

 f) Favorite: You will need to show the items that are your favorites. You will place a 

checkmark in a box to show that you like it or leave it blank to show that you do 

not. 

What is your favorite item? 

   

 

 

 
 

 

 

NOTE: 

ID: Microsoft Access needs each record to have a unique ID. This is called a primary key. 

Microsoft Access will automatically assign a number to each record in your database. You 

do not need to do anything. 
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Assignment 11: Blast Off on a Cyberspace Mission 
 

 
 

Use a Search Engine to Find Information 

 Open a web browser. 

Load a search engine such as www.google.com or www.bing.com. 

 Type a search word and then press ENTER. 

 

 Click on a website link that has information about your topic. 

 Record the information in the form on the next page. 

 

Save a Picture as a JPEG 

 Right click on the picture you like. 

Depending on the browser, pick Save image as  

or Save picture as.  

 Go to the place where you save your work.  

 Rename the picture to something relevant. 

 Click the Save as type arrow and select JPEG. 

 

 Click Save. 

 Record that you have obtained a picture in the form on the next page. 

 

 

  

You are going to blast off into cyberspace using a 

web browser.  

 

You will use a search engine to find information 

about your topic. Once you find the information, 

you will record it in the form.  

 

You must collect information for SIX records. In the 

previous assignment you picked categories to sort 

the records. You need to have at least one record 

for each category. 

TIP: If the jpeg file type is unavailable, 

save the picture to your student folder as 

is. Then open the picture using Microsoft 

Paint and resave it as jpeg format. 
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Record the Details for Each Item 

Item Name  
  

Description  

 
  

Date  Category  
  

Favorite  Picture   SAVE THE PICTURE AS A JPEG 

 

 

Item Name  
  

Description  

 
  

Date  Category  
  

Favorite  Picture   SAVE THE PICTURE AS A JPEG 

 

 

Item Name  
  

Description  

 
  

Date  Category  
  

Favorite  Picture   SAVE THE PICTURE AS A JPEG 

 

 

Item Name  
  

Description  

 
  

Date  Category  
  

Favorite  Picture   SAVE THE PICTURE AS A JPEG 

 

 

 

Item Name  
  

Description  

 
  

Date  Category  
  

Favorite  Picture   SAVE THE PICTURE AS A JPEG 

 

 

 

Item Name  
  

Description  

 
  

Date  Category  
  

Favorite  Picture   SAVE THE PICTURE AS A JPEG 
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Assignment 13: Create a Form 
 

 
 

Open the Saved Database in Microsoft Access 

 

Create a Form using the Form Wizard 

 Click to highlight the table in the Navigation Pane. 

 

 Click the Create tab.   

 From the Forms group, click Form Wizard.  

 Click  to select all the fields in the table. Click Next. 

 
 

 Select Columnar from the layout options. Click Next. 

 
 

  

Make a simple data entry form from the table you 

made in the previous session. Add the objects 

collected from the cyberspace mission into the 

database form. 
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 If necessary, type a title for the form.  

 Select Open the form to view or enter information. 

Click Finish. 

 

 The blank form opens. 

 
 

Edit the Form in Design View 

 

 Click the View  arrow on the Home tab.  

From the list, select Design View.  

 

Apply a Theme to the Form 

You can apply a theme to a form by selecting an option from the gallery. 

Themes apply a pattern to the header, change the background fill color, 

adjust the font, and set the borderline around a control.  

 On the Form Design tab, click Themes.  

Pick a style from the gallery. 

 
  

Design View lets you edit a form. In this view, you can resize controls. A 

control is an object on a form, such as a text box. 
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Resize a Control on a Form 

You may want to resize the controls. For example, the picture control may not 

be tall enough and the item name field may be too wide. 

 Click on a control you want to change. 

 Place the mouse pointer over the border of a control.  

 When the mouse pointer changes to a two-way arrow, drag IN to make the control 

smaller or OUT to make the control larger. 

 

 REPEAT UNTIL EACH CONTROL IS A SIZE YOU LIKE. 

 
 

 

 

 
 

 

Save the Form 

 

Test the Form by Entering a Record in Form View 

Now that you have applied a style to the form and resized the controls, it is a 

good idea to test data entry. 
 

Switch to Form View and add a test record. Once you are certain that the fields 

are set correctly, you can delete the record. 

 

Switch to Form View 

 From the Form Design tab, click View.  

 Choose Form View.  

 

  

If you need to make the form taller, place the mouse pointer above the 

Form Footer bar. When it changes to a two-way arrow, click, and drag 

the mouse downwards. 

Do you need to move a control? Click to select the control then hold the SHIFT key and 

click on the label of the same field. Now use the keyboard ARROW keys to move the 

control OR drag into place on the form. 

 

Do you need to move more than one control? Hold the SHIFT key then click on each item 

you want to move. Use the ARROW keys or the drag to move the selection. 

Label 
Control 
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Add a Test Record 

 Type Test in the Item Name field. 

 Type This is a description in the Description field. 

 Pick a date from the calendar  in the Date field or type the date using the correct 

format. 

 Pick a category from the Category field. 

 Put a checkmark in the Favorite field. 

 Right click inside the Picture field. Look to see if a menu shows up that has the option 

Insert Object. 

 
 

Delete the Test Record 

 Open the table. 

 

 Move the mouse to the start of the record row.  

When you see the black arrow , click to select the entire row; or record.  

 Return to the Home tab. Click the Delete  arrow and choose Delete Record.  

 

 When asked if you want to delete the record, click Yes. 

 

Close the Table and the Form and Exit Microsoft Access 

 If prompted, save the changes to the form. 

 

If the form looks good and each control is a suitable size for data entry, then you can 

DELETE the record. 
 

If you DO NOT like the style, or a control is TOO SMALL or TOO LARGE,  

return to Design View and make changes to the form.  
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Assignment 14: Add Records Using the Form 
 

 
 

Open the Database in Microsoft Access 

 Double click the form name in the Navigation Pane. 

 
 

Add Information for the First Record into the Form 

 Refer to the planning sheet from Assignment 11 and enter in the information for the first 

record: 

o Type an item name in the Item Name field. 

o Type facts in the Description field. 

o Pick a date from the calendar in the Date field or type the date. 

o Pick a category from the Category field. 

o Put a checkmark in the Favorite field if it is your favorite or leave blank if it is not. 

 

 
  

Use the simple data entry form to add a record for 

each object researched on the cyberspace mission. 

 

TIP: You will need the completed planning sheet from 

Assignment 11.  
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Add a Picture for the First Record into the Form 

  

 KEEP THE DATABASE OPEN TO THE BLANK FORM. 

 Open the picture in Microsoft Paint. 

 
 

 Click the Select arrow and click Select All. 

 In the Clipboard group, select Copy.  

 Return to the database form. 

Right click inside the picture field and choose Paste.  

 
 

Add Remaining Records 

 

 From the Home tab, in the Records group, click New.  

or click the New (blank) record  in the navigation bar.  

 Type information into each field on the form. 

 Insert a picture of the object. 

 

Close the Form and Exit Microsoft Access 

  

Your Windows device comes with a built-in image program called Paint. 

Use Paint to open and copy your picture to the clipboard. You can then 

paste it into the picture field on the form. 

Open an image in Paint 

Option 1: Go to the location of the picture. Right click on the file and choose Open with 

from the menu. Choose Paint. 

 

Option 2: Click Start on the Windows taskbar. From the Windows Accessories category, 

choose Paint. Click File>Open and browse to the location of your image. 

You need to add the remaining five records. For each record, you will 

need to use the New command to add a blank form. Use this form to 

enter the information and picture about the object. 
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Form Checklist (Optional) 

Self-Evaluation: Study the records in your 

database. Complete the checklist: 
 

 Name of Student: YES NO 

1. The form has an attractive style.   

2. The controls are large enough to read all the information in a field.   

3. There are six records entered into the database.   

4. Every record has each field completed.   

5. The item name for each item is correct.   

6. The description about each item includes interesting facts.   

7. The categories used to classify each object are correct.   

8. There is at least one record per category.   

9. There is at least one record that is marked as Favorite.   

10. The picture selected for each object is suitable.   

 
Peer-Evaluation: Show the records you have entered into the form to a friend. Ask your friend to look at the 

records and complete the checklist: 
 

 Name of Friend: YES NO 

1. The form has an attractive style.   

2. The controls are large enough to read all the information in a field.   

3. There are six records entered into the database.   

4. Every record has each field completed.   

5. The item name for each item is correct.   

6. The description about each item includes interesting facts.   

7. The categories used to classify each object are correct.   

8. There is at least one record per category.   

9. There is at least one record that is marked as Favorite.   

10. The picture selected for each object is suitable.   

 
Teacher-Evaluation: Show the records you have entered into the form to your teacher. Ask your teacher to 

complete the checklist after looking at the records: 
 

 Name of Teacher: YES NO 

1. The form has an attractive style.   

2. The controls are large enough to read all the information in a field.   

3. There are six records entered into the database.   

4. Every record has each field completed.   

5. The item name for each item is correct.   

6. The description about each item includes interesting facts.   

7. The categories used to classify each object are correct.   

8. There is at least one record per category.   

9. There is at least one record that is marked as Favorite.   

10. The picture selected for each object is suitable.   

TIP: Check your spelling. Click 

the Home tab. From the 

Records group, click Spelling.  
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Session 5 Review: About Forms 

 

Complete the crossword. 

 

4.  W        

I        

Z        

A        

R   5.  D     

1.  D E L E T E   

   S     

 2.  Q U I C K   

   G   6.  F  

 3.  C O N T R O L 

      R  

      M  

 

 

Across 

1. This tool   is used to _____ a record. 

2. The Save command is on the _____ Access Toolbar.  

3. An object on a form such as a label or data entry box is called a _____. 

  

Down 

4. The Form _____ can be used to complete a set of steps to make a form quickly. 

5. A view used to edit a form. 

6. _____ View can be used to add records. 
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Session 5 Skill Review: Food Groups Form 

 

Follow the instructions to make a form that categorizes food by their group. 

 

1. Open Microsoft Access. 

2. Create a blank database: 

 a) Click Blank database. 

 b) Type Food as the file name. 

 c) Click Browse and save the database to your student folder. Click OK. 

 d) Click Create. 
   

3. Add Food as a Short Text field. 

 a) Click the column heading Click to Add. 

 b) Select Short Text from the menu. 

 c) Type Food as the field name. Press ENTER. 

   

4. Add Group as a Lookup & Relationship field. 

 a) Click the column heading Click to Add. 

 b) Select Lookup & Relationship from the menu. 

 c) Select I will type in the values that I want. Click Next. 

 d) In Col1 type the following values: 

  

• milk and alternatives 

• fruits and vegetables 

• grain products 

• meat and alternatives 

 e) Click Next. Type Group in the label field. 

 f) Click Finish. 

 g) Save the table as Food Groups. 
  

5. Save the changes.  
  

6. Close the table. 
  

7. Create a form: 

 a) Select the Food Groups table in the Navigation Pane. 

 b) Click the Create tab. 

 c) Click Form Wizard in the Forms group.  

  d) Click the Select All Fields button. Click Next. 

 e) Select Columnar from the layout options. Click Next. 

 f) Type Food Group Form as the form title. 

 g) Click Open the form to view or enter information. 

 h) Click Finish. 
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8. Enter records to classify food items: 

 a) Add a record for each food item in the list. Classify the food group for each item. 

  

 cereal  carrot  rice  cheese 

 apple  bread  sausage  ice cream 

 chicken  fish  yogurt  grapes 
  

9. Save the changes.  
  

10. Filter the records by food group using the Selection command: 

 

Fruits and Vegetables 

 a) Type fruit in the Search Box in the navigation bar.  

  The first record with fruit shows up in the document pane. 

 b) On the Home tab, click Selection   in the Sort & Filter group. 

 c) From the list, pick Begins With "fruit." 

 d) Look at the Filter Indicator. It shows that the records are filtered.  

  Use the navigation arrows to view the food in the fruits and vegetables group. 
   

11. What food in the database is your favorite in the fruits and vegetables group? 

  

  

 e) Remove the filter.   
    

 Meat and Alternatives 

 a) Type meat in the search box.  

  The first record with meat shows up in the document pane. 

 b) On the Home tab, click Selection  in the Sort & Filter group. 

 c) From the list, pick Begins With "meat." 

 d) Look at the Filter Indicator. It shows that the records are filtered.  

  Use the navigation arrows to view the food in the meat and alternatives group. 
   

12. List the foods in the meat and alternatives group: 

  

  

 e) Remove the filter.   
    

13. Close the form. 
  

14. Exit Microsoft Access. 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 5 Extension Activity: Customize a Form 

 

You can format the way a form looks. Try it! 

 

1. Open your database in Microsoft Access. 

2. Right click on the form. Select Design View.  

3. Select the controls you want to change.  

4. Use the commands on the Form Design Format tab  

to change the look of the form: 

 

 
  Change the font. 

 
    Change the font size. 

 
   

 
Apply the bold style. 

 
   

 
Apply the italic style. 

 
   

 
Apply the underline style. 

 
   

 
Select a font color. 

 
   

 
Set the color of a control. 

     Align text to the left. 

     Center text. 

     Align text to the right. 

 
   

 
Set the color of the border around a control. 
(This tool is in the Control Formatting group.) 

      

5. Save changes to the form.  

6. Close the form. 

7. Exit Microsoft Access. 
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Report Marking Sheet 
 

Report Design and Layout 
 

The information on the report is grouped by category. 
/1 

Each item in the group is sorted alphabetically. 
/1 

The field ID is deleted from the report. 
/1 

The report has an attractive style. 
/1 

The page orientation is set to landscape. 
/1 

The controls on the report fit between the page margins. 
/1 

The controls on the report have an appealing layout. 
/1 

  

Report Content 
 

There are at least six records on the report. 
/6 

Each record has the item name listed correctly. 
/6 

The records are correctly categorized. 
/6 

Each record contains interesting facts. 
/12 

Each record has a suitable picture. 
/6 

Each record has a date that clearly labels the type (collected, released, birthday). 
/6 

At least one record is marked as Favorite. 
/1 

TOTAL /50 

 

 

 




